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 Safety precautions 
The following safety precautions should be observed before using this product and any associated instrumentation. Although 
some instruments and accessories would normally be used with nonhazardous voltages, there are situations where hazardous 
conditions may be present. 

This product is intended for use by qualified personnel who recognize shock hazards and are familiar with the safety precautions 
required to avoid possible injury. Read and follow all installation, operation, and maintenance information carefully before using 
the product. Refer to the user documentation for complete product specifications. 

If the product is used in a manner not specified, the protection provided by the product warranty may be impaired. 
 

The types of product users are: 

Responsible body is the individual or group responsible for the use and maintenance of equipment, for ensuring that the 
equipment is operated within its specifications and operating limits, and for ensuring that operators are adequately trained. 

Operators use the product for its intended function. They must be trained in electrical safety procedures and proper use of the 
instrument. They must be protected from electric shock and contact with hazardous live circuits. 

Maintenance personnel perform routine procedures on the product to keep it operating properly, for example, setting the line 
voltage or replacing consumable materials. Maintenance procedures are described in the user documentation. The procedures 
explicitly state if the operator may perform them. Otherwise, they should be performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and repair products. Only properly trained 
service personnel may perform installation and service procedures. 
 

Keithley Instruments products are designed for use with electrical signals that are measurement, control, and data I/O 
connections, with low transient overvoltages, and must not be directly connected to mains voltage or to voltage sources with high 
transient overvoltages. Measurement Category II (as referenced in IEC 60664) connections require protection for high transient 
overvoltages often associated with local AC mains connections. Certain Keithley measuring instruments may be connected to 
mains. These instruments will be marked as category II or higher. 

Unless explicitly allowed in the specifications, operating manual, and instrument labels, do not connect any instrument to mains. 

Exercise extreme caution when a shock hazard is present. Lethal voltage may be present on cable connector jacks or test 
fixtures. The American National Standards Institute (ANSI) states that a shock hazard exists when voltage levels greater than 
30 V RMS, 42.4 V peak, or 60 VDC are present. A good safety practice is to expect that hazardous voltage is present in any 
unknown circuit before measuring. 

Operators of this product must be protected from electric shock at all times. The responsible body must ensure that operators 
are prevented access and/or insulated from every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect themselves from the risk of electric shock. If 
the circuit is capable of operating at or above 1000 V, no conductive part of the circuit may be exposed. 
 

Do not connect switching cards directly to unlimited power circuits. They are intended to be used with impedance-limited 
sources. NEVER connect switching cards directly to AC mains. When connecting sources to switching cards, install protective 
devices to limit fault current and voltage to the card. 

Before operating an instrument, ensure that the line cord is connected to a properly-grounded power receptacle. Inspect the 
connecting cables, test leads, and jumpers for possible wear, cracks, or breaks before each use. 

When installing equipment where access to the main power cord is restricted, such as rack mounting, a separate main input 
power disconnect device must be provided in close proximity to the equipment and within easy reach of the operator. 

For maximum safety, do not touch the product, test cables, or any other instruments while power is applied to the circuit under 
test. ALWAYS remove power from the entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, such as installing or removing jumpers. 
 

Do not touch any object that could provide a current path to the common side of the circuit under test or power line (earth) 
ground. Always make measurements with dry hands while standing on a dry, insulated surface capable of withstanding the 
voltage being measured. 
 

For safety, instruments and accessories must be used in accordance with the operating instructions. If the instruments or 



 

 

accessories are used in a manner not specified in the operating instructions, the protection provided by the equipment may be 
impaired. 

Do not exceed the maximum signal levels of the instruments and accessories, as defined in the specifications and operating 
information, and as shown on the instrument or test fixture panels, or switching card. 

When fuses are used in a product, replace with the same type and rating for continued protection against fire hazard. 

Chassis connections must only be used as shield connections for measuring circuits, NOT as protective earth (safety ground) 
connections. 

If you are using a test fixture, keep the lid closed while power is applied to the device under test. Safe operation requires the use 
of a lid interlock. 

If a  screw is present, connect it to protective earth (safety ground) using the wire recommended in the user documentation. 

The  symbol on an instrument means caution, risk of danger. The user must refer to the operating instructions located in the 
user documentation in all cases where the symbol is marked on the instrument. 

The  symbol on an instrument means caution, risk of electric shock. Use standard safety precautions to avoid personal 
contact with these voltages. 

The   symbol on an instrument shows that the surface may be hot. Avoid personal contact to prevent burns. 

The  symbol indicates a connection terminal to the equipment frame. 

If this  symbol is on a product, it indicates that mercury is present in the display lamp. Please note that the lamp must be 
properly disposed of according to federal, state, and local laws. 

The WARNING heading in the user documentation explains dangers that might result in personal injury or death. Always read 
the associated information very carefully before performing the indicated procedure. 

The CAUTION heading in the user documentation explains hazards that could damage the instrument. Such damage may 
invalidate the warranty. 

Instrumentation and accessories shall not be connected to humans. 

Before performing any maintenance, disconnect the line cord and all test cables. 

To maintain protection from electric shock and fire, replacement components in mains circuits — including the power 
transformer, test leads, and input jacks — must be purchased from Keithley Instruments. Standard fuses with applicable national 
safety approvals may be used if the rating and type are the same. Other components that are not safety-related may be 
purchased from other suppliers as long as they are equivalent to the original component (note that selected parts should be 
purchased only through Keithley Instruments to maintain accuracy and functionality of the product). If you are unsure about the 
applicability of a replacement component, call a Keithley Instruments office for information. 

To clean an instrument, use a damp cloth or mild, water-based cleaner. Clean the exterior of the instrument only. Do not apply 
cleaner directly to the instrument or allow liquids to enter or spill on the instrument. Products that consist of a circuit board with 
no case or chassis (e.g., a data acquisition board for installation into a computer) should never require cleaning if handled 
according to instructions. If the board becomes contaminated and operation is affected, the board should be returned to the 
factory for proper cleaning/servicing. 

Safety precaution revision as of January 2013. 
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Welcome 
Keithley’s Parametric Curve Tracer configurations are complete solutions configured with a variety of 
high quality instruments, cables, test fixtures, and software. This building block approach offers the 
advantages of easy upgrade or modifications to meet changing test needs. For example, a low cost 
200 V at 10 A system can be purchased initially, and 50 A or 100 A capability can be added later. 
Additionally, you can use these instruments and accessories with different test system platforms, 
such as for reliability or device qualification testing. 

Keithley’s Parametric Curve Trace configurations include everything you need to quickly develop a 
complete test system. 

ACS Basic Edition software provides complete device characterization, including both real-time trace 
mode for quickly checking fundamental device parameters like breakdown voltage and full parametric 
mode for extracting precise device parameters. ACS Basic Edition goes beyond traditional curve 
tracer interfaces by offering a broad array of sample device libraries. More important, you have 
complete control of all test resources, allowing you to create more advanced tests than previously 
possible on a curve tracer. 

 

Introduction to this manual 
This manual describes how to set up and use the Parametric Curve Tracer, including: 

• Assembling the PCT 
• Getting the software running 
• Performing tests with the software, using both Trace mode and Parametric Test mode 

This manual provides detailed applications to help you achieve success with your Keithley 
Instruments PCT. 

Each application is presented with an overview of the application, followed by instructions to complete 
the application. 

 

Section 1 

Introduction 
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Available configurations 
Model Collector / Drain Supply Step Generator Auxiliary 

Supply 
High Voltage 
Mode 

High Current 
Mode 

Base / Gate 
Supply 

Low Power 2600-PCT-1B 200 V / 10 A 200 V / 10 A 200 V / 10 A N/A 

High Current 2600-PCT-2B 200 V / 10 A 40 V / 50 A 200 V / 10 A 200 V / 10 A 

High Voltage 2600-PCT-3B 3 kV / 120 mA 200 V / 10 A 200 V / 10 A 200 V / 10 A 

High Current 
and High 
Voltage 

2600-PCT-4B 3 kV / 120 mA 40 V / 50 A 200 V / 10 A 200 V / 10 A 

The Keithley Instruments Model 2651A may be added to increase High Current Mode to either 50 A 
or 100 A. Other available accessories include the PCT-CVU Multi-frequency Capacitance-Voltage (C-
V) Meter, the Model 8010 High Power Device Test Fixture, the Model 8020 High Power Interface 
Panel, and the CVU-200-KIT and CVU-3k-KIT bias tee kits. 

 

Extended warranty 
Additional years of warranty coverage are available on many products. These valuable contracts 
protect you from unbudgeted service expenses and provide additional years of protection at a fraction 
of the price of a repair. Extended warranties are available on new and existing products. Contact your 
local Keithley Instruments office, sales partner, or distributor for details. 

 

Contact information 
If you have any questions after you review the information in this documentation, please contact your 
local Keithley Instruments office, sales partner, or distributor, or call Keithley Instruments corporate 
headquarters (toll-free inside the U.S. and Canada only) at 1-800-935-5595, or from outside the U.S. 
at +1-440-248-0400. For worldwide contact numbers, visit the Keithley Instruments website 
(http://www.keithley.com). 

 

 

http://www.keithley.com/
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Introduction 
You must connect the instruments to either the Model 8010 High Power Device Test Fixture or the 
Model 8020 High Power Interface Panel and then set up the TSP-Link network. The cables supplied 
with your PCT can be used with either fixture. This section will show you how to make these 
connections. 

If you choose to install the instruments in a rack, rack-mount the units first before connecting the 
instruments to the test fixture or interface panel.  Please refer to the instructions in the rack mount kits 
for more information. 

 

Unpacking the PCT 
Each PCT configuration is shipped with the latest version of the ACS Basic Software CD-ROM 
(Keithley Instruments part number ACS-950-01). For the latest drivers and additional support 
information, see the Keithley Instruments website (http://www.keithley.com). 

Within the PCT shipping container is a single box labeled "Open Me First" that contains all the 
instrument accessories, user documentation, and ACS Basic Edition software. Within this box, the 
accessories for each instrument in your configuration are enclosed in individual boxes and bags. 
Each box also includes a Product Announcement document describing the contents of each box. 

On the same shipping pallet are each SMU of your PCT configuration, as well as any other PCT 
accessories, such as a Model 8010 High Power Device Test Fixture, a Model 8020 High Power 
Interface Panel, the PCT-CVU instrument option, or the optional 200 V or 3 KV bias tee kits. 

The PCT is generally connected to either a Model 8010 or a Model 8020. The following section 
provides overview for these devices. 

 

Section 2 

Instruments and connections 

http://www.keithley.com/
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About the Model 8010 High Power Device Test Fixture 
The Model 8010 High-Power Device Test Fixture provides a safe, low noise, complete environment 
for testing a variety of packaged device types. The replaceable socket module test boards allow for a 
variety of package types, including the user-supplied socket types. 

The Model 8010 allows you to connect one Model 2657A High Power SourceMeter for up to 3 KV 
testing. You can connect up to two Model 2651A High Power SourceMeters for 15 A DC testing or 
50 A or 100 A pulse testing. For lower power terminals, you can connect up to two other 
SourceMeters, such as Models 2611A, 2612A, 2635A, 2636A, 4200-SMU or 4210-SMU. 

The Model 8010 includes: 

• Kelvin (remote sense) connections for five instruments 
• Guarded pathways for picoampere level measurements even at 3 KV 
• An access port for a variety of probes, such as scope or temperature 
• Integrated protection circuits to protect Models 2611A, 2612A, 2635A, 2636A, 4200-SMU, and 

4210-SMU from high voltage instruments 
• Two independent test sockets, one for high current and one for high voltage 

The test fixture is fully interlocked, providing safe operation for up to six different instruments. It is 
declared safe through CE marking and certified through nationally recognized testing laboratories. 

The Model 8010 is shipped with two 8010-DTB high power socket module test boards installed. The 
boards include sockets for TO-247 and axial lead devices. 

Additional socket module test boards are available. The 8010-CTB Customizable Test Board allows 
you to add your own socket. The 8010-DTB-220 Test Board is for use with three-terminal TO-220 or 
TO-247 devices and is limited to 1000 V and the maximum rated current of the test fixture. 
Additionally, the 8010-DTB-CT Curve Tracer Adapter Test Board allows you to use the same socket 
style installed in Tektronix Series Curve Tracers. 

For information on the Model 8010, including fixture setup within a test system, see the Model 8010 
High Power Device Test Fixture User's Manual, available at the Keithley Instruments website 
(http://www.keithley.com). 

 

http://www.keithley.com/
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About the Model 8020 High Power Interface Panel 
The Model 8020 has six measurement pathways accommodating 3 kV, 200 V, and 100 A 
measurements. You can configure five of the pathways with a variety of output connector types to 
match your probe station. You can configure four pathways with the optional bias tees. This provides 
high voltage C-V measurements on up to 4 pins of the device under test. 

The Model 8020 comes with a selection of resistors that you can install to provide stability and extra 
protection to the device. 

Additionally, the Model 8020 offers the following: 

• A common LO reference 
• Overvoltage protection for all 200 V channels, ideal for device testing configurations using 200 V 

SMUs and higher voltage SMUs 
• A variety of connector types 
• A single interlock interface for multiple instruments 
• An interface for adding series resistor elements for measurement stability and absolute current 

limit 
• Optional transient overcurrent protection on the 200 V channels 
• Expansion ports to easily link multiple 8020 interface panels 

The Model 8020 can be configured to suit your particular probe station and test system. Contact your 
Keithley Instruments applications engineer or see the Model 8020 High Power Interface Panel User's 
Manual, available at the Keithley Instruments website (http://www.keithley.com) 

 

Safety connections 

Connections to protective earth (safety ground) 

The ground wires must be attached to a known protective earth (safety ground) before 
powering on instruments. Failure to attach the ground wires to a known protective earth 
may result in electric shock. 

Connections to protective earth (safety ground) are made at terminals labeled with the following 
symbol. 

Figure 1: Protective earth (safety ground) symbol 

 

For detailed Model 8010 and Model 8020 instrument connections diagrams, including safety ground 
details, see Connect instruments to the Model 8010 (on page 2-5) or Connect instruments to the 
Model 8020 (on page 2-6). 

 

http://www.keithley.com/
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Interlock connections 

For proper interlock functionality, any instruments connected to the interlock must be powered on or 
else disconnected from the interlock. 

Each Parametric Curve Tracer configuration contains instruments that can output hazardous live 
voltages. To ensure operator safety, it is important to use the instrument interlock properly with the 
Model 8010 and Model 8020 test fixtures. Both the Model 8010 and Model 8020 include interlock 
connectors to interface with Series 26xx and 4200 instruments. Refer to the instrument connection 
diagrams later in this section for illustrations on how to connect to the individual SMU instruments. 

With the Model 8010, the interlock switch is engaged when the lid is closed and latched. When the 
interlock switch is engaged, a light on the enclosure is illuminated. You can turn on a SMU output 
only when the interlock switch is engaged. If the lid is open, the interlock switch will not engage and 
any SMUs with outputs that are configured for high voltage will not turn on. 

For the Model 8020, the Interlock OUT connector on its device connections panel side of the unit is 
designed for use with the supplied 8020-ILC-UNT interlock to unterminated cable. The interlock 
enables the high voltage outputs of the connected instruments when the normally-open switch at the 
DUT access point is closed. 

The Model 8020 interlock is satisfied only when: 

• The top cover to the 8020 is correctly installed and any top covers to other Model 8020s in the 
test configuration are also correctly installed 

• The system interlock is engaged (all normally-open switches are closed at DUT access points of 
the test configuration) 

When the 8020 interlock is satisfied, LEDs on the instrument connections and device connections 
panels of the 8020 are illuminated. 

For detailed information on the interlock requirements for the Model 8010 or Model 8020, see the 
reference manual for that test fixture. For detailed information on the interlock requirements for a 
specific SMU, see the reference manual for that SMU. 

There is no safety interlock on the Model 2651A. The safety interlock is not necessary for this SMU 
because its output voltage is below hazardous levels. To activate Output Enable, refer to the Model 
2651A Reference Manual. Output Enable can be activated using the front panel or by remote control. 
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Connect instruments to the Model 8010 
The following diagram depicts connections for I-V and C-V measurements. If you need to make only 
connections for I-V measurements, refer to the Model 8010 User's Manual. 

Figure 2: Instrument connections to the Model 8010 
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Connect instruments to the Model 8020 
Figure 3: Connecting instruments to the Model 8020 
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Introduction 
ACS Basic Edition software is optimized for parametric testing of component and discrete (packaged) 
semiconductor devices.  ACS Basic supports all of Keithley's source and measure instrument 
products, including Series 2600B, Series 2400, and Models 2651A and 2657A SourceMeter 
Instruments, Model 237 SMU, and Model 4200-SCS SMUs. 

ACS Basic has a large device test library to allow you to get a test up and running quickly.  

This section will outline how to configure the instruments in the PCT to prepare for connection to ACS 
Basic, how to install the software, and how to get started using the software. 

 

Installing and configuring the GPIB interface 
 

If you have ordered the PCT-CVU for high voltage capacitance measurements, a GPIB interface 
comes installed on the Model 4200-SCS that is included with the PCT-CVU. There is no need to use 
a separate computer or install the KUSB-488B. Move ahead to TSP-Link system setup, where you 
will Assign TSP-Link node numbers (on page 3-2). 

Section 3 

Getting started with ACS Basic 
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ACS Basic software will work with the following GPIB interfaces: 

• KUSB-488 
• KUSB-488A 
• KUSB-488B 
• KPCI-488 
• KPCI-488A 
• KPCI-488LP 
• KPCI-488LPA 
• NI USB-488 
• NI PCI-488 

If one of the above interfaces is already installed on your computer, please continue to TSP-Link 
system setup. 

The PCT is supplied with Keithley’s Model KUSB-488B GPIB interface. When you are using a 
separate PC for software control, first install the GPIB interface if there is not one already installed on 
the PC. The GPIB driver CD and the GPIB interface are located in the "Open Me First" box shipped 
with the PCT. Insert the CD and follow the on-screen instructions to install the driver and the GPIB 
interface. 

 

TSP-Link system setup 
ACS Basic automatically assigns the SMU identification numbers based on the TSP-Link setup. The 
numbers will differ based on your PCT configuration. 

 

Assign TSP-Link node numbers 
Each instrument in the TSP-Link network must have a unique TSP-Link node number. In addition, 
ACS Basic requires that you set the master node to TSP-Link node number 1 and that each node that 
is connected to the master has an incremental node number. For example, if you have a TSP-Link 
network with three nodes, you must assign the instruments to the node numbers 1, 2 and 3. Do not 
skip numbers. 

In PCT configurations, use the Model 2636B as the master node, assigned to node number 1. When 
present in the PCT, the Model 2657A should be assigned Node Number 2. The Model 2651A should 
be assigned to 3 only in with the PCT-3B and -4B configurations; with a PCT-2B configuration, the 
Model 2651A should be assigned to Node 2. If you have a second Model 2651A, assign it to the 
subsequent node number. 

While other node configurations are possible, these assignments allow for simpler use of the default 
ACS Basic tests. 

1. To assign a node number from the front panel of the instrument: 
2. Press the MENU key, then select TSPLINK > NODE. 
3. Press the navigation wheel  and select the desired number. 
4. Press the ENTER key to save the node number. 
5. Press the EXIT key as needed to return to the main display. 
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Connect the instrument for communications 
All configurations require a KUSB-488B or similar GPIB adapter cable Model 2636B connecting the 
instrument and your computer. For additional connections, see the below details for your PCT 
configuration. 

The 2600-PCT-1B configuration is shipped with the Model 2636B. The KUSB-488B or similar GPIB 
adapter cable linking the Model 2636B and your computer is the only connection. 

The 2600-PCT-2B configuration is shipped with the Models 2636B and 2651A. For this configuration, 
connect the TSP-Link port of the Model 2636B to the TSP-Link port of the Model 2651A. 

The 2600-PCT-3B configuration is shipped with the Models 2636B and 2657B. For this configuration, 
connect the TSP-Link port of the Model 2636B to the TSP-Link port of the Model 2657A. 

The below graphic shows a 2600-PCT-4B configuration. The -4B configuration is shipped with the 
Models 2636B, 2651A, and 2657B. 

 

Figure 4: Communications connections 
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ACS Basic software 
ACS Basic software can be installed on any computer that meets the minimum configurations as 
described below. Additionally, ACS Basic software is supported on a computer/laptop for the Series 
2600B System SourceMeter® units, the Model 4200-SCS, and other external GPIB instruments. 

It is recommended that you back up your previous version of ACS or ACS Basic before installing a 
new version of the software. 

Minimum configuration for a computer: 

Operating System: Microsoft® Windows® XP Professional Service Pack 3 (SP3), Windows 7 x 86 
(32-bit), or Windows 7 x 64 (64-bit). 

• CPU: Pentium 4, 2.4 GHz+ or equivalent  
• System Memory (RAM): 1 GB 
• Hard Disk: 600 MB free space  
• Graphics Card: 16 MB of VRAM  
• Screen: 1024 x 768, 32-bit True Color  

Recommended configuration for a computer: 

Operating System: Microsoft Windows XP Professional Service Pack 3 (SP3), Windows 7 x 86 
(32-bit), or Windows 7 x 64 (64-bit). 

CPU: Intel® dual core class, AMD Athlon® class or higher 

• System Memory (RAM): 2 GB  
• Hard Disk: 1 GB free space  
• Graphics Card: 64 MB of VRAM  
• Screen: 1280 x 1024, 32-bit True Color  

ACS Basic software can use GPIB cables to communicate with instruments. Before using ACS 
Basic, you need to make sure that the GPIB driver is functioning properly in your operating system 
(Windows XP Professional Service Pack 3 or Windows 7). 

 

Software installation 

If you have a PCT-CVU, then the ACS Basic software is already installed on its computer. You can 
skip ahead to the Start ACS Basic section of this manual. 
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Before installing ACS Basic, make sure you have read and have completed all of the pre-installation 
requirements (see the previous topic). 

ACS Basic installation instructions: 
1. Log into Windows as an administrator. 
2. Insert the ACS Basic setup disk into the CD-ROM. 
3. The CD should open automatically. If it does not open, click My Computer, and open the CD. 
4. Find the file named launch.exe and double-click. 
5. When the CD opens you can click on the software to start the installation. 
6. Once the ACS Basic Setup Wizard dialog box opens, follow the instructions to install the software 

on your system. 
7. When the installation process is complete, the Temporary License Generation dialog box opens 

(see next figure). 

Figure 5: Temporary license generation dialog box 

 

8. If you already have a USB license key, select "Do not generate license, keep in demo mode" in 
order to continue installation. The USB key for ACS Basic is inside the box labeled "Open Me 
First" within your shipping carton. 

After you have installed ACS Basic software, and before you begin to set up any projects or run any 
tests, it is recommended that you review the Release Notes. The Release Notes contain valuable 
information about known issues and provide guidance on how to handle issues that you may 
encounter. To find the Release Notes, click the Windows Start icon > All Programs > ACS Basic 
> Reference > Release Notes or from the Help menu in the ACS Basic menu toolbar. 
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Start ACS Basic 

FATAL ERROR POSSIBLE. To avoid fatal errors to instruments, never start the ACS Basic software 
until all the instruments have completed self-testing. If you are using Series 2600 and 2600B 
instruments with TSP-Link, always power-on the subordinate instruments first, and then the master. 
Since the master scans through all the linked subordinate instruments, it must be powered-on after 
all the subordinate machines are turned on, or errors may occur when you start ACS Basic. 

Before you open the ACS software, make sure that all instruments are turned on and all self-tests 
have completed. 

You must also locate the license key, which is included with PCT and located in the "Open First" 
shipping box. The ACS Basic SafeNet Sentinel USB license key is similar to a standard USB flash 
drive (see next figure). The USB license key allows you to operate ACS Basic in the professional 
mode and can be moved from one computer to another (multiple installations) without buying 
additional licenses. 

Figure 6: USB SafeNet Sentinel license key 
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To start the ACS software: 
1. Insert the USB license key into the USB port of the computer. The computer and ACS Basic 

software will automatically detect the USB key. 

Do not remove the USB key from the computer while you are using the ACS Basic software. If the 
key is removed, you will receive a warning message that indicates you have 30 seconds to reinsert 
the USB key in the computer. After the key is reinserted, you must click Continue  to keep ACS Basic 
functioning. If the key is not reinserted before the time has elapsed, the ACS Basic software closes 
and you will lose all data from your session. 

2. Select the ACS software icon on your computer’s desktop. The User Login dialog box opens (see 
next Figure).  

Figure 7: User login 
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3. Type a user name and password in the User Name and Password fields. The default user name 
is ACSADMIN; however, there is no default password. 

More than one new user account can be established at this time. You can establish new accounts by 
clicking the New User button. To change the password, click the Change Password button. 

4. Click OK. The ACS software start window opens (see next figure). 

Figure 8: ACS software start window 

 

When you start the ACS Basic software, the startup time will depend on how many instruments are 
in the hardware configuration group. For example, if there are several instruments, the startup time 
will be longer. 
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Verify hardware configuration 
When you first start up ACS Basic, the Hardware Change Info dialog box is displayed, as shown 
below. This dialog box is displayed whenever ACS Basic detects a change in hardware. 

ACS Basic automatically assigns the SMU numbers. The numbers will differ based on your PCT 
configuration and TSP-Link node numbers. See Assign TSP-Link node numbers (on page 3-2) for the 
recommended TSP-Link configuration. 

Figure 9: Hardware change info 

 

To verify the hardware configuration: 
1. In the Scanned Hardware Info list, click + display the list of hardware. 
2. Verify that all the SMUs in your system were detected. 
3. Use the mouse to hover over the each SMU in the tree to display information about the SMU. 
4. If the information is correct, select the option "Update scanned info and enter ACS online mode." 
5. Click Continue. 

If one or more SMUs are missing: 

• Ensure that the GPIB adapter is securely attached to instrument and is working. 
• Ensure that all instruments are powered on. 
• Ensure that all TSP-Link cables are secure. 

After checking the instruments, click Re-Scan to scan the hardware configuration again. 
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ACS basic test modes 
ACS Basic has three test modes. The following table lists each mode and its usage. 

Mode Usage 
Single-test Open and run a single test on a single device at a time 

Multi-test Create multiple test modules on one or more devices and organize them into a single project. 
For example, Multi-test mode can perform multiple tests on a single device (target 
application) or multiple tests on multiple devices (secondary use case). 
You can work with external instruments (DMMs, switches, and so on) in Multi-test mode much 
easier than in any other mode. 

Trace Trace mode is for interactive operation with a source meter unit. Trace mode is useful for 
quickly checking the operating boundaries of a device and for verifying its basic functionality.  

In the following sections of this manual, you will learn how to perform common power semiconductor 
tests in Multi-test mode and in Trace Mode. 

 

Configure ACS Basic to use the correct device interface 
ACS Basic uses the Device Interface Setting to manage the hardware configuration for  optimizing 
the default instrument settings.  For correct optimization, open the Hardware Configurator by 
selecting the Configure Hardware icon on the toolbar. Next, select "Device Interface Setting" in the 
left navigation pane. See the following two graphics for details. 

Figure 10: Hardware Configurator icon 

 

Figure 11: Hardware configurator 
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Configure the device interface setting in ACS Basic: 
1. Select the radio button of the model of your test fixture or device interface. 
2. Select Bias Tee checkbox option if you are using any of the following bias tees: Model CVU-3K-

Kit, Model CVU-200-KIT, Model 8020-CVU, or Model 4205-RBT. 
3. Select the Apply button. 
4. Return to the test setup area of ACS Basic by clicking the test setup icon in the Toolbar (see 

below graphic). 

Figure 12: Test setup icon 
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Section overview and equipment requirements........................ 4-1 
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Section overview and equipment requirements 
This section provides step-by-step instructions to the user on how to use the Parametric Curve Tracer 
(PCT) to perform common tests on a sample power MOSFET device. These tests include collecting 
family of curves (Vds-Id) on a power MOSFET and measuring leakage current (Idss) using the 
various modes and features of the ACS Basic software. 

The following instructions are tailored to the 2600-PCT-4B that has both high voltage and high current 
capability. However, the test parameters can be adjusted to suit the PCT configuration and 
instrumentation that you have. 

The PCT is provided with a sample test device, located in the PCT-DOC-KIT box of the "Open Me 
First" box. The sample device is a 1000 V MOSFET and is available from Fairchild Semiconductor as 
part number FQH8N100C. You can download a datasheet for this part from the manufacturer's 
website:  http://www.fairchildsemi.com (http://www.fairchildsemi.com). 

This section refers to SMUs that are numbered as suggested in Assign TSP-Link node numbers (on 
page 3-2). Individual configurations can vary. 

 

Section 4 

I-V applications for power MOSFETs 

http://www.fairchildsemi.com/
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On-state characteristics 

Configure the test fixture 

The PCT supports either the Keithley Instruments Model 8010 or Model 8010 test fixtures. For 
instructions on how to connect instruments to the 8010 or 8020, refer to Section 2, Instruments and 
connections (on page 2-1). To make connections to the device, follow one of the below procedures 
depending on your test fixture. 

To configure the Model 8010 test fixture: 
1. On the High Current side of the fixture, insert the test device into the test socket. Place the device 

with the Gate pin closest to the front of the test fixture. 
2. Wire the test fixture as shown in the diagram below: 

• Connect the 2651A HI and SHI signals to the Drain terminal. 
• Connect the 2600A #1 HI and SHI signals to the Gate terminal. 
• Connect the LO and SLO signals from both SMUs to the Source terminal. 

Figure 13: Three-terminal DUT with one or two 2651A instruments and Series 2600A 
instrument connected 
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To configure the Model 8020 test fixture: 
1. Wire the test fixture as shown in the diagram below: 

• Connect both COMMON LO, SLO signals and the COMBINED 2651 LO signal to the Source terminal of 
the device. 

• Connect the COMBINED 2651 SHI and HI signals to the Drain terminal of the device. 
• Connect both 2600/4200 SHI and HI signals to the Gate terminal of the device. 

Figure 14: 8020 test fixture configuration (device side) 
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Collecting I-V curves in trace mode 
Trace mode allows you to generate rapid visual results of device characteristics as well as providing 
real-time control of one of the test parameters. This example application will instruct you on how to 
collect a family of curves on a MOSFET device.  

The PCT is provided with a sample device, located in the PCT-DOC-KIT box of the "Open Me First" 
box shipped with your PCT configuration. The sample device is a 1000 V MOSFET and is available 
from Fairchild Semiconductor as part number FQH8N100C. You can download a datasheet for this 
part from the manufacturer's website at http://www.fairchildsemi.com http://www.fairchildsemi.com. 

These instructions demonstrate how to do the following tasks: 

• Configure Trace mode  
• Gather a family of curves on a MOSFET using Trace mode 
• View and save data in Trace mode 

To do the test, you will do the following steps: 

1. Enter Trace mode of ACS-Basic 
2. Load the IdVd_StepVg test for the nPowerMOSFET device into the project 
3. Configure the settings to match the DUT 
4. Run the test 
5. View and save the data 

Trace mode only supports the Series 2400, Series 2600B, and the Models 2651A/2657A. However, 
you cannot connect a Series 2400 and a Series 2600B instrument to the same device. If you are 
using a Series 2400 on one device terminal, you must use a Series 2400 instrument on the other 
device terminal(s). However, you can use a Series 2600B and a Model 2650A instrument in any 
combination. Also, Trace-mode only supports the SCPI protocol for Series 2400 SMUs. 

Trace mode provides interactive control of SMU instruments to achieve real-time performance. Only 
Series 2600B instruments (Models 2601B/2602B, 2611B/2612B, 2635B/2636B), Series 2650A 
(Models 2651A, 2657A) and Series 2400 instruments (Models 2400, 2401, 2410, 2420, 2425, 2440) 
are supported. ACS Basic can perform DC and pulse tests on Series 2600B, and 2650A instruments 
in Trace-mode, but it can only perform DC measurements on Series 2400 instruments. 

See the following graphic. The GUI includes: 

1. Device setting: used to map the SMU, select the test module, and set the advanced settings. 
2. Test setting: used to set the test information when the test module is enabled. 
3. Trace Test Data: used to show the test result. 

Figure 15: Trace-mode test GUI 

http://www.fairchildsemi.com/
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To collect curves in Trace mode: 
1. Launch ACS Basic. 
2. Switch to trace mode by selecting TraceMode from the mode selection drop-down. 

Figure 16: Selecting TraceMode option 
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3. Select nPowerMOSFET from the Device drop-down. 

Figure 17: Selecting nPowerMOSFET 

 

4. Select IdVd_StepVg from the Test Modules drop-down. The test loads with default settings and 
sample data. 

Figure 18: Selecting IdVd_StepVg 
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5. Connect a SMU to the desired device terminal by clicking the button next to the device terminal 
and selecting the appropriate SMU. In the below example, SMU 4 is connected to the Drain 
terminal. 

Figure 19: Selecting a device terminal for SMU assignment 

 

6. Select the SMU resource to connect to this device terminal. For this example, we want to connect 
the high current SMU (2651A, SMU 4) to the Drain. 

Figure 20: SMU 4 settings 
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7. Click the OK button to complete the SMU settings.  
8. Repeat for the remaining device terminals. For this example, we want to connect 2636A Channel 

A (SMU1) to the gate and connect the Source to the GND terminal, which represents the 
Common LO terminal. 

9. You can now change the Stepping values. In this instance the gate SMU will step from 5 - 7 V in 
0.5 V increments. Therefore, the Number of Steps is 5, the Offset Value is 5 V, the Max Source 
Value (V) is 7, and the Step Direction is set to Positive. See the below figure. 

Figure 21: Stepping settings 

 

10. Select your Acquire/Trigger option in Force Mode. The Acquire/Trigger option selects whether the 
sweep runs once or repeatedly. For this example, select the "repeat" option. See the below 
figure. 

Figure 22: Force Mode options 

 

11. To adjust the sweeping characteristics, move the Sweeping slider to 0% so that no voltage is 
applied to the DUT when you start the test. See the below figure. 
a. For this example, change the Peak Voltage to 10 and make sure that the Sweep Direction is Positive. 

Figure 23: Sweeping slider at 0 percent of peak voltage 
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12. To complete the Sweeping and Stepping SMUs configuration, click the Advanced Settings button 
near the lower-left part of the application window to display the Advanced Settings dialog window 
(see the below graphic). 

Figure 24: Advanced Settings dialog window 

 



Section 4: I-V applications for power MOSFETs Series 2600-PCT-xB Parametric Curve Tracer User's Manual 
 

4-10 PCT-900-01 Rev. A / January 2015 

 

The Advanced Settings are automatically configured based upon the type of test being run. 
However, values can be changed to suit the DUT. 

13. Adjust the primary Advanced Settings: 
• Ensure that the Sense mode is "remote" for both Gate and Drain SMU 
• On the drain, change Compliance to 10 A and Meas Range to 10 A 
• On the gate, change the Compliance to 100 mA 
• Change the Duty Cycle to 5 % 

The pulse duty cycle of the pulses impacts the update rate of the display. Using a lower duty cycle 
will allow higher current without thermal stress to the device. However, a lower duty cycle means that 
the display will not update as quickly as in this example. 

14. Click the OK button to accept the changes. 
15. Click the Run icon at the top of the application to begin the test. If you configured the 

Acquire/Trigger mode to "Single", you will need to select the "Single Run" button to start 
collecting data. With the "Repeat" option, data collection begins when the "run" icon is selected. 

Figure 25: Run icon 

 

16. Move the Sweeping slider as desired to adjust the peak voltage. Notice that the I-V curves sweep 
out further as you move the slider right. 

Figure 26: Test results 
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You can also use the arrows keys on the keyboard to adjust the slider. The up and down arrow keys 
result in coarse changes in the sweeping voltage of 10 % of peak voltage The left and right arrow 
keys result in fine changes in the sweeping voltage of 1 % of peak voltage.  

17. Stop the test by clicking the Stop icon at the top of the application window. 
 

Configure a fixed plot 
As you increase the sweep voltage, the graph automatically scales to fit the collected data into the 
plot. If you prefer a fixed-graph window, follow these steps: 

1. Right-click within the plot, then select Plot and Axis Settings from the pop-up menu to display the 
Plot Settings dialog window. 

Figure 27: Selecting the plot and axis settings window 
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2. Select the Axis Settings tab from the Plot Settings window. 

Figure 28: Plot settings dialog window 

 

3. Make the following modifications to the X-Axis Scale: 
a. Uncheck Auto 
b. Change the X-Axis Scale Min to 0 
c. Change the X-Axis Scale Max to 10 

4. Make the following modifications to the Y-Axis Scale: 
a. Uncheck Auto 
b. Change the Y-Axis Scale Min to 0 
c. Change the Y-Axis Scale Max to 10 

5. Change the X and Y Axis Title Text: 
a. Re-name the X-Axis title to "Vds (Volts)" 
b. Re-name the Y-Axis title to "Ids (Amps)" 

6. Click the Save button. 
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Collecting I-V curves in multi-test mode 
Introduction 
In Single-Test and Multi-Test modes, you program all test parameters prior to test operation. Tests 
run without operator intervention or interaction. These modes are useful for generating precise data 
on the DUT and for extracting device parameters from the data set. 

In this example application, you will collect a family of curves on the sample MOSFET (Fairchild part # 
FQH8N100C) n Multi-Test Mode. Download a datasheet for this part from www.fairchildsemi.com 
http://www.fairchildsemi.com. 

This example application demonstrates how to do the following tasks: 

• Create a MultiMode project in ACS Basic 
• Add tests to the project using the built-in test libraries 
• Configure a test in Multi-test mode 
• View, append, and save data in Multi-test mode 

To do the test, you will do the following steps: 

1. Place the DUT into the Model 8010 test fixture and configure the connections 
2. Enter Multi-Mode of ACS-Basic 
3. Create a new Multi-Mode project 
4. Load the IdVd_StepVg test for the nPowerMOSFET device into the project 
5. Configure the settings to match the device under test 
6. Run the test 
7. Save the data 

First, let's review the multi-test mode Graphical User Interface. 
 

Multi-test mode GUI overview 
The configuration navigator (see next figure) has the following logical hierarchy: 

• Project 
• Device 1 

• Test module 1 (ITM, STM, or PTM) 
• Test module 2 (ITM, STM, or PTM) 

• Device 2 
• Test module 1 (ITM, STM, or PTM) 
• Test module 2 (ITM, STM, or PTM) 

 

http://www.fairchildsemi.com/
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Figure 29: Multi-test mode GUI 
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The configuration navigator is the primary interface for building, editing, and viewing a project plan, 
and for specifying and accessing each project plan component. 

When you select a navigator component (test or device) you can do the following: 

• Add a new component 
• Delete an existing component 
• Run the tests associated with this component 

Clicking on a navigator component opens the configuration interface on the right panel that includes 
settings, test results, and status information. 

The next figure displays the typical project plan components that are displayed in the configuration 
navigator. 

Figure 30: Configuration navigator view, project plan components displayed 

 

1. Project Plan: Defines and sequences all devices tested, and all tests/operations to be performed 
at each. It typically corresponds to one die on a wafer. 

2. Device Plan: Defines and sequences all tests for a specific device, including transistors, diodes, 
and resistors. 

3. ITM: Completely defines a parametric test without programming, using a series of easily 
configured graphical user interfaces which show data numerically and graphically in real time. 
Provides for the display of both raw data and analyzed data. 

 

Configure the test fixture 
The connections to the test fixture for this test using the Model 8010 and Model 8020 test fixtures are 
the same as for the Collecting IV Curves in Trace Mode and Digitizing Pulses and Improving Timing. 
Please see the Configure the test fixture (on page 4-2) topic in either section for details. 
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Set up a new MultiMode project 
You can use the ACS Basic Multi-test mode to create multiple test modules on one or more devices 
and organize them into a single project. You can work with external instruments, such as DMMs and 
switches, in Multi-test mode more easily than in any other mode. 

MultiMode starts with the most recently used MultiMode project. In this application, you replace it with 
a new project. 
To set up a new MultiMode project: 
1. Start ACS Basic, if it is not already open. 
2. From the Mode Selection list on the operation toolbar, select MultiMode. 

Figure 31: Selecting MultiMode 

 

3. From the File menu, select New. 

Figure 32: Creating a new project 
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4. Select No to the prompt to save the current project. The New Test Project dialog box opens (see 
the next figure). 

Figure 33: New test project window 
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5. In the Project Name field, enter a project name. 
6. Click OK. 

When the new project opens, the project navigation pane on the left is empty and the test libraries 
area fills the remainder of the window. The test libraries area is the easiest way to add devices and 
tests to your project. 

Figure 34: Project navigation and test libraries 

 
 
 

Add the IdVd_StepVg test to the project 
To add the IdVd_StepVg test to the project: 
1. From the Select a Device pane, select nPowerMOSFET. 

Figure 35: nPowerMOSFET selected on the Select a Device pane 
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2. Select the IdVd_StepVg test from the Test Modules pane at the bottom left of the window. 

Figure 36: D 

 
 

3. Click Add Test. The device and test is added to your project tree. 

Figure 37: Device and test added to project tree 
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4. In the Project Tree, click the device nPowerMOSFET_26. The Device Settings dialog box opens. 

Figure 38: Device Settings dialog box 

 

In the Device Settings dialog box, you can configure which SMU is connected to which pin of the 
device, set the SMU sense mode, and assign a name to the pad. This SMU mapping applies to all 
tests in the project tree located under the device. 

When you added the test to the project, ACS BASIC automatically assigned SMUs to the pins. You 
should verify that the pin assignments are correct: 

• Make sure that the high current SMU (for this example, model 2651A, SMU 4) is connected to the 
drain 

• Make sure that the 2636A Channel A (SMU 1) is connected to the gate 
• Make sure that both the gate and drain are configured for remote sense 
• Make sure that the source terminal is connected to GND 

 

Configure the test 
You configure the settings each test in the Test Definition dialog box. From this dialog box, you can 
set every aspect of how your test runs. Many of the settings are pre-configured, but you need to make 
some changes for this application. 

You can check your SMU assignments by hovering the mouse cursor over the pad numbers in the 
device diagram. 
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This section refers to SMUs that are numbered as suggested in Assign TSP-Link node numbers (on 
page 3-2). Individual configurations can vary. 

To set up the IV curve test: 
1. In the project navigator, click the test named IdVd_StepVg. 
2. For SMU4 (drain), confirm that Compliance is set to 10 A. 
3. For SMU4 (drain), set the Meas. Range to 10A. 
4. For SMU1 (gate), confirm that Compliance is set to 0.1 A. 
5. For SMU4 (drain), double-click the Source Settings cell to open the Sweep V Settings dialog 

box. 

Figure 39: Changing Source settings 

 
 

6. Set the Mode to Linear. 
7. Set the Start value to 0. 
8. Set the Stop value to 10. 
9. Set the Step value to 0.1. 
10. Set the Base value to 0. 
11. Click OK. 

Figure 40: Modified Sweep V Settings 
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12. For SMU1 (gate), double-click the Source Settings cell to open the Step V Settings dialog box. 
13. Set the Start value to 5. 
14. Set the Stop value to 7. 
15. Set the Points value to 5. 
16. Set the Base value to 0. 
17. Click OK. 

Figure 41: Modified Step V Settings 

 
 



Series 2600-PCT-xB Parametric Curve Tracer User's Manual Section 4: I-V applications for power MOSFETs 
 

PCT-900-01 Rev. A / January 2015 4-23 

 

Run the test 
The Data tab contains the data from the last time the test was run. Because this test is new, it 
contains sample data. When the test is run, the new data overwrites the sample data. 
To run the test: 
1. Select the Data tab of the Test dialog box. 
2. Click Run ( ) to start the test. Once data collection is complete, the test will stop. 
3. At the top of the Data tab, select Plot Only to get a better view of the plot. 
4. Select Data Only to get a better view of the data in the spreadsheet. 
5. Select Plot and Data to return to the dual view. 
6. As the test runs and ACS Basic collects data, the curves are displayed on the graph. 

Figure 42: Test result curves and data 
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You can also run the test without overwriting the existing data. This is useful for comparing data 
between two devices or doing a before and after comparison after making some changes to the test 
settings or device connections. 
To run the test and append data: 
1. Click Append Run to start the test. 

Figure 43: Append Run icon 

 

After the test runs, you should see the appended data graphed on the plot next to the original data 
and an additional tab on the datasheet that holds the new data. Because we have not made any 
changes, the curves of the appended data should align with the original curves. If the curves align, 
this is a good indicator that you are making settled measurements. If they do not align, there could be 
a problem with your test configuration. 

 

Save project and data 
When you save the project with the Save All icon, all your test settings and collected data are saved 
with it so the next time you load ACS-Basic and open the test your settings and data will still be there. 
You can also save the data to a Microsoft Excel spreadsheet or to a .csv file for analysis in another 
application. 
To save a project: 
1. Click the Save icon in the top toolbar. 

Figure 44: Saving project 

 

To save test data: 
1. Above the plot window in the test results window are radio buttons to change the data view. For 

this example, select Plot and Data. 

Figure 45: Data view options in test results window 
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2. Click the Save icon at the bottom of the plot. 

Figure 46: Saving test data 

 

3. The Save to File dialog window gives you many file format options for saving the test data. The 
default is .xls. 

Figure 47: Save to File dialog window 

 

In addition to .xls, you can also save in .csv, .png, .ps, .eps., and .svg formats. Select the "Save as 
type" drop-down above before you click the Save button to change file formats. 
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Digitizing pulses and improving timing 
Introduction 
For many devices, you must adjust the measurement timing to produce good test results. 

In particular, you may need to increase the pulse width to give the test signal more time to settle 
before making the measurement. Often test engineers will use an oscilloscope to see what the pulse 
looks like and determine the proper pulse width and measurement time from this information. The 
Series 2650A SMUs feature a built-in 18-bit fast analog-to-digital (ADC) converter that can digitize the 
pulse without the need of the scope. This application demonstrates how to use the fast ADC to 
digitize the output of the SMU to examine the shape of the pulse. 

To introduce you to digitizing pulses, this application shows you how to do the following  tasks: 

• Adjust timing settings 
• Digitize the pulse from a data point in the test 
• Plot digitized data 
• Read the digitized pulse to configure the correct timing settings 

To do the test, you will do the following steps: 

1. Load the IdVdStepVg test that was created in Multi-test mode (see "Collecting I-V curves in trace 
mode" on page 4-4). 

2. Configure the test to digitize a pulse. 
3. Configure the plot to display the digitized data. 
4. Adjust the timing settings and then use the digitizer to review the changes. 

 

Configure the test fixture 
The connections to the test fixture for this test using the Model 8010 and Model 8020 test fixtures are 
the same as for the Collecting IV Curves in Trace Mode and IV Curves in Multi-test mode. Parametric 
Mode. Please see the Configure the test fixture (on page 4-2) topic. 

 



Series 2600-PCT-xB Parametric Curve Tracer User's Manual Section 4: I-V applications for power MOSFETs 
 

PCT-900-01 Rev. A / January 2015 4-27 

 

Configure the test to digitize a pulse 

For instructions on creating a new IdVd_StepVg test, refer back to Add the IdVd_StepVg test to the 
project (on page 4-18). 

1. Make sure that you have the IdVd_StepVg test selected, then click the Definition tab. 
2. Click the Timing button (highlighted in the following graphic) to open the ITM Timing window. 

Figure 48: Highlighted timing button in 
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Configure the General Timing tab settings 

The ITM Timing window (General Timing tab) is where you configure SMU output timing and 
measurements. The following table describes each of the setting categories. 
ITM Timing window, General Timing tab setting categories 

Category Function 
Speed Settings for adjusting the measurement aperture of the integrating ADC 

and configuring any averaging 
DC Parameters Timing settings for outputting DC signals. Most of these settings can only 

be changed if the test is running under DC Only Mode, which is set in the 
Test Definition window 

General Parameters Settings for the period between data points and for when the 
measurement will be taken relative to the start of the period. 

Pulse Timing  
1 / 2 Parameters 

For configuring the Pulse Width of any pulse signals as well as 
specifying when the pulse will be output relative to the start of the period 

Force Mode Assignments Displays which SMUs have been assigned to each of the three timing 
configurations 

Figure 49: ITM Timing window 
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In the above graphic, the output preview at the bottom of the application window is based upon the 
settings for the DC, Pulse Timing 1, and Pulse Timing 2 categories. 
Preview output definitions 

1 Start of a period 

2 End of a period 

3 Measurement trigger time 

4 Measurement aperture (area) 
 

To ensure good pulsed measurements, this aperture must be contained entirely within the width of 
the pulse. It should also be placed far enough from the leading edge of the pulse to ensure that the 
signal has settled before the measurement is started.  

To capture digitized pulse waveforms, make sure to capture the timing data by selecting the 
Timestamp Enabled checkbox in the ITM Timing window. 

You will also enable and configure Pulse Transient Mode. See the next topic in this section for details. 
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Configure the Pulse Transient tab settings 

The Pulse Transient tab of the ITM Timing window is where you enable and configure the digitizer of 
the 2650A Series SMUs. The following table describes each of the settings. 

Figure 50: ITM Timing window, Pulse Transient tab 
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ITM Timing window, Pulse Transient tab setting categories 

Setting tion 
Pulse 
Transient 
Mode 

Used to digitize a single point of the step/sweep sequence. Checking the Pulse Transient 
Mode box enables the mode and the controls to configure the mode 

Single point / 
Entire 
step/sweep 

Controls whether ACS Basic will go directly to the selected step/sweep point and digitize it or 
if it will run through the entire step/sweep sequence to digitize the selected point. To get to 
results quickly, use the Single Point option. However, you might find that the data you get 
when going directly to the point differs from the data you get when you run the entire sweep. 
This is most commonly due to device self-heating. To see results that most closely match 
the output when the full test is ran, select Entire step/sweep 

Transient Start 
/ Transient 
End 

Sets the start and end times of the digitizing window and are relative to the start of the 
period. This window is represented in the above graphic by the blue shaded area. 

Sweep Point / 
Step Point 

Selects which points in the step/sweep sequence you want to digitize 

SMU Info Displays the programed levels for the SMUs at that step and sweep point. By default, the 
last point of the step/sweep sequence is selected, which corresponds to the point where 
there is 7 V on the Gate and 10 V on the Drain. 

Force Mode 
Assignments 

Displays which SMUs have been assigned to each of the three timing configurations 

1. Select Step and Sweep points that correspond to a Gate voltage of 6.5 V and a Drain voltage of  
5 V. 

2. Select the "Pulse Transient Mode" checkbox to enable pulse transient mode. 
3. Set Transient Start to 0. 
4. Set Transient End to 1e-3. 
5. Set the Sweep Point to 51. 
6. Set the Step Point to 4. 
7. Click the OK button to accept your changes. 
8. Switch to the Data tab. 
9. Click the run icon to start the test.  
10. Your results (shown on the Data tab) will resemble the following graphic. 

Figure 51: ITM Timing test results 
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By default, the graph for the IdVd_StepVg test is configured to show current versus voltage. To get a 
scope-like view we need to plot the signals versus time. Since the default plot is already setup for 
displaying the IV curves of the device, it is preferable to not make any changes to its settings when 
trying to view the digitized data. Instead, create a new plot to graph the data. 
Create a new plot 
1. Click the plot icon, then select New Plot. 

Figure 52: New Plot 

 

2. In the XY Settings window, scroll down to time(4) 
3. Select time(4) under X 
4. Select V_Drain(4) for Y1 
5. Select I_Drain(4) for Y2 

Figure 53: XY Settings window 
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The digitized data now appears on a second plot to the right of the original. The voltage waveform is 
shown on the plot in red while the current waveform is show on the plot in blue. 

Figure 54: New digitized data 

 
 

Adjust the pulse timing settings 
Now that we are able to see the waveform in the plot, we will observe what happens when we change 
some of the timing settings. 

1. Click the Definition tab. 
2. Click the Timing button. 

Figure 55: Timing example waveform 
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In this test, the Drain is configured to use Pulse Timing 1 while the Gate is configured to use Pulse 
Timing 2. The default settings have the rising edge of the Gate signal (Pulse Timing 2) 60 µs before 
the rising edge of the Drain signal and the falling edge of both signals occurring at the same time. 

3. Change the Pulse Width of Pulse Timing 1 to 5e-4 (500 µs). 

Figure 56: Pulse Width of Pulse timing changed 

 



Series 2600-PCT-xB Parametric Curve Tracer User's Manual Section 4: I-V applications for power MOSFETs 
 

PCT-900-01 Rev. A / January 2015 4-35 

 

4. Change the Pulse Width of Pulse Timing 2 to 6e-4 (600 us). 
5. Set the measure delay to 4e-4 (400 us). 
6. Set the period to 5e-3 (50 ms). 
7. Click the OK button to accept your changes. 
8. Select the Data tab of the Test dialog box. 
9. Click Run ( ) to start the test. 

Figure 57: Graphed results 

 

After you run the test, you should see a graph similar the one above. These results show that the 
signal settles quickly, so DC measurements with these timing parameters should produce repeatable 
measurements. 
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Off-state characteristics 

Configure the test fixture 

The PCT supports either the Keithley Instruments Model 8010 or Model 8010 test fixtures. Follow 
one of the below procedures depending on your test fixture. 

To configure the Model 8010 test fixture: 
1. On the High Voltage side of the Model 8010 test fixture, insert the test sample device into the test 

socket. Place the device with the Gate pin closest to the front of the test fixture. 
2. Wire the test fixture as shown in the diagram below: 

• Connect the 2657A HI signal to the Drain terminal. 
• Connect the 4200/2600 #2 signal to the Gate terminal. 
• Connect the LO terminals of the 2657A and the 4200/2600 #2 signal to the Source terminal. 

Figure 58: Leakage current measurement test fixture configuration 
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To configure the Model 8020 interface panel: 
1. Wire the test fixture as shown in the diagram below: 

• Connect the LO signal to the Source terminal of the device. 
• Connect the 2657 HI signal to the Drain terminal of the device. 
• Connect the 2600/4200 #1 HI signal to the Gate terminal of the device. 

Figure 59: Configuring the 8020 interface panel for leakage current measurement 
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Measuring leakage current in multi-test mode 
Introduction 
Characterizing a semiconductor device in its off-state includes leakage current measurements and 
requires sourcing a voltage and measuring a small current. This measurement require very sensitive 
equipment with proper guarding and shielding to make an accurate measurement. The Parametric 
Curve Tracer handles each of these requirements so that the user can get results quickly and easily. 

To introduce you to measuring leakage current, this application shows you how to use Multi-test 
mode to perform an Idss test on a high voltage MOSFET using the sample part provided in the PCT-
DOC-KIT (Fairchild part # FQH8N1100C).  Download a datasheet for this part from 
www.fairchildsemi.com (http://www.fairchildsemi.com) to compare data taken with the device specs.  

To do the test, you will do the following steps: 

1. Configure the connections to the device 
2. Add the Idss test to the project 
3. Configure the test settings to suit the DUT 
4. Run the test and obtain the leakage current from the device 

 

Add and configure the Idss test 
1. Click on Project in the Project Navigation Tree to display the Test Libraries window. 

Figure 60: Test Libraries window 

 

http://www.fairchildsemi.com/
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2. Select the nPowerMOSFET device from the Select a Device pane at the top of the window. 
3. Select the IDSS test from the Test Modules pane at the bottom left of the window. 
4. Click the Add Test button to add the test to your project. 
5. Select New device, then click the OK button. 
6. You will now see a device nPowerMOSFET_26_1 in your project tree. Right-click on the device 

and select Rename. 
7. Change the name to nPowerMOSFET_HV. 
8. Press <Enter> to save the change. 

Figure 61: New device in project navigation tree 
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9. Select the nPowerMOSFET_HV device. 
10. Use Pads-SMUs mapping, then follow one of the next steps, depending on your test fixture. 

• For the Model 8010, attach SMU 3 (2657A) to the Drain and the SMU2 (2636B SMU B) to the 
Gate 

• For the Model 8020, configure the SMU3 (2657A) to the Drain and SMU1 (2636B SMU A) to the 
Gate 

11. Set the Sense Mode for both SMUs to Local.  
12. Configure the Source terminal to GND. 

Figure 62: Device Settings window (Model 8020 connections) 

 

13. Select the Idss test under the IGBT_26 device in the Project Navigation Tree. 
14. Click the Definition tab. 
15. Set the Source value to 1000 V. 

Figure 63: Setting Source value to 1000 V 
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16. For the gate SMU (SMU 1 or SMU 2), set the source function to GND. 
17. Set the compliance (current limit) of both SMUs to 1 mA. 
18. Select measurement of current and voltage for SMU 3 (2657). 

If you want to profile the leakage current of the device as a function of voltage, set the source 
function to sweep V. Configure the sweep settings in the Source field. 

19. Select the Data tab. 

Figure 64: Data tab 

 

20. Sample data for the DSS test is displayed. 

Figure 65: Data tab with sample DSS test data 
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The current through the device and the voltage across the device are plotted versus time on the 
graph. This test works by sourcing the test voltage and taking many readings. The readings are then 
averaged to give you a final value. 

You can adjust the number of samples taken and averaged in the Timing window of the test. Under 
General Parameters, enter the desired number of readings for "# Sample." See the below graphic. 

Figure 66: Sample quantity adjustment 

 

You can also configure the test to stop if the compliance (current limit) is reached. Check the "stop on 
compliance" checkbox to have the test automatically stop if any SMU reaches current limit.   
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Run the test 
1. Click the Run icon to start the test. 

Figure 67: Data and results of IDSS test 
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The data you collect should look similar to the data seen here. While the voltage data may appear 
noisy at first, take note of the scale of the plot. You can simplify the plot by adjusting the scale for the 
voltage readings in the Data tab. 
To simplify the plot: 
1. Right-click the graph and select Plot and Axis settings. 

Figure 68: Plot and Axis settings 
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2. Select the Axis Settings tab. 
3. For Y2, un-select the "auto" checkbox and set the min and max values to 999.55 and 1000.55 

respectively. 

Figure 69: Plot and Axis settings window 

 

4. Click the Save button. 

You can improve the stability of the current measurements by adjusting the timing. Accurate low 
current measurements typically involve significant settling time and longer integration times. 
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To refine the Idss results: 
1. Open the ITM Timing window by selecting the "Timing" button.  
2. Set the Hold Time to 1 s. 
3. Set the speed to Slow.  
4. By default, auto delay is enabled, but you can add delay time. Set the Measure Delay to 0.25 s, 

which will set the SMU to delay 250 ms beyond the auto delay time for increased settling. See the 
below graphic for an example. 

Figure 70: ITM Timing window with settings 
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5. Click OK to apply the settings. 
6. Click the Run button 
7. Note the improved Idss results. Your refined results should be similar to those in the below 

graphic. 

Figure 71: Refined Idss results 

 

The datasheet for the sample device specifies a 10 µA maximum value for Idss. The measured 
leakage current should be much smaller than the specification. Such specifications are typically 
created using traditional curve tracers, which have limited current measurement resolution and are 
generally unable to measure currents less than 10 μA. If the measured value exceeds the 
specification, then the device is likely damaged. Verify connections and then re-test. 
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Overview and requirements 
This section will cover circuit-level power MOSFET capacitance measurements on a device up to 
3 kV using a Keithley Instruments Model 8020 with the optional 8020-CVU installed or the Model 
8010 with the CVU-3K-KIT option and a 2600-PCT-3B with the PCT-CVU accessory unit. 

See the Model 8010 and Model 8020 User Guides, available on the Keithley Instruments website 
(www.keithley.com (http://www.keithley.com)) for connection information on 2 terminal devices and for 
component-level capacitance measurements of power MOSFETs. 

 

Background of MOSFET capacitance measurements 
There are two different ways to look at the capacitance of three-terminal power semiconductor 
devices such as MOSFETs, BJTs, and IGBTs: at the component level and at the circuit level. Looking 
at the capacitances at the component level involves a characterization of capacitance between every 
device terminal. Looking at the capacitance at the circuit-level involves a characterization of the 
combination of component level capacitances. 

As an example, the below figure illustrates the component level capacitances of a power MOSFET. 

Figure 72: Component level capacitances for power MOSFET 

 

Section 5 

C-V applications on power MOSFETs 

http://www.keithley.com/
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The next 3 figures illustrate the relationship between the component level and circuit-level 
capacitances for a power MOSFET. Similar capacitance measurements can also be made for BJT 
and IGBT devices. 

Figure 73: Diagram of input capacitance for a power MOSFET 

 

Figure 74: Diagram of output capacitance for a power MOSFET 

 

Figure 75: Diagram of reverse transfer capacitance for a power MOSFET 

 

Device capacitance typically varies with applied voltage. Complete characterization of the DUT 
requires knowledge of the capacitance at the maximum rated voltage. The remainder of this section 
will review the safety precautions, connection diagrams between the instrumentation, the Model 8020, 
and the DUT for high voltage capacitance measurements. 
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Safety precautions and discharge procedures 

Discharging bias tee capacitance within the Model 8010 
The capacitance of the bias tees in the Model CVU-200-KIT and CVU-3K-KIT can hold charge. 
Devices with sufficient capacitance can also hold charge. A shock hazard exists if a proper discharge 
is not performed and you open the Model 8010 cover and touch one of the instrument or device 
terminals within the fixture. Never assume that the safety interlock discharges the system. 

The Model 2657A SMU is programmed in ACS Basic to safely discharge the bias tee and device 
capacitance after completing a high voltage C-V test. However, an operator error, a power outage, or 
an unforeseen event can leave a dangerous charge in the system. Therefore, the Model CVU-3K-KIT 
includes the 8020-DP High Voltage Discharge Probe. Use this discharge probe to manually discharge 
the bias tee capacitance and system capacitance within the Model 8010 by touching the banana 
jacks and BNC connectors inside of the fixture. 

See the below graphic for an overview of the Model 8020-DP High Voltage Discharge Probe. 

Figure 76: Model 8020-DP High Voltage Discharge Probe 
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Perform system capacitance discharge with the Model 8020-DP High Voltage Discharge Probe: 
1. Connect the Model 8020-DP High Voltage Discharge Probe ground connection cable to an 

unused protective earth screw on one of the bias tees. 

Figure 77: 8020-DP connected to bias tee protective earth screw 
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Do not stack cable connectors on the protective ground screw. Connect only to an unused screw. 

2. Open the lid of the Model 8010 test fixture. 
3. While holding the 8020-DP by the handgrip only, use the probe tip to contact the terminals on the 

device test board that connect the HI and SHI terminals of the 2657A (see the following 2 
graphics). 

Figure 78: Contacting the HI terminal of the Model 8010 test board 

 

Figure 79: Contacting the SHI terminal of the Model 8010 test board 
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4. If there is no cable connected to the HI and SHI connections of the 2657A, use the discharge 
probe to contact the center conductors of the HI and SHI BNC connectors. 

Figure 80: Contacting the HI BNC connector of the Model 8010 test fixture 

 

5. Maintain contact for at least 1 second to safely discharge system capacitance. 
6. Contact the GUARD banana jack of the Model 2657A. 

Figure 81: Contacting the GUARD banana connector of the Model 8010 test board 

 

7. Maintain contact for at least 1 second.  
8. Repeat discharge procedure on the HI and SHI terminals of the Model 2600/4200 within the 

Model 8010 fixture. 
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Discharging bias tee capacitance within the Model 8020 
The 8020-CVU option for the Model 8020 has internal capacitance that can hold charge.  A shock 
hazard exists if a proper discharge is not performed and the user removes the 8020 top cover or in 
other ways accesses a live terminal in the system.   Never assume the safety interlock discharges the 
system. 

Be sure to use the SMU to discharge the capacitance properly after each test and before removing 
the top cover of the 8020 or accessing live terminals in the system.  The Model 2657A SMU is 
programmed in ACS Basic to safely discharge the bias tee and device capacitance after completing a 
High Voltage CV test. A user error or another unforeseen event, such as a power outage, can leave a 
dangerous charge in the system, the Model 8020 with the 8020-CVU option includes a high voltage 
discharge probe, Model 8020-DP. Use this discharge probe to manually discharge the bias tee 
capacitance and system capacitance prior to making adjustments on the 8020 main board or at the 
device interface. 

See the below graphic for an overview of the Model 8020-DP High Voltage Discharge Probe. 

Figure 82: Model 8020-DP High Voltage Discharge Probe 

 

Perform system capacitance discharge with the Model 8020-DP High Voltage Discharge Probe: 
1. Connect the Model 8020-DP High Voltage Discharge Probe ground connection cable to an 

unused protective earth screw on the Model 8020 (see the below graphic). 

Figure 83: Protective earth (safety ground) screw locations on the Model 8020 
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Do not stack cable connectors on the protective ground screw. Connect only to an unused screw. 

2. Remove the top cover of the Model 8020 High Power Interface Panel. 
3. While holding the 8020-DP by the handgrip only, use the probe tip to contact each of the posts at 

notes 1a, 1b, and 2 on the Model 8020 main board for the high voltage channel and each of the 
200 V channels (see the following graphic). 

Figure 84: Contacting nodes on the Model 8020 main board 

 

4. Maintain contact for at least 1 second to safely discharge system capacitance. 
 

Discharge system capacitance from SMU front panel interface 
If you are controlling the SMUs from the front panel interface, a best practice is to discharge system 
capacitance with the SMU output on. Configure the SMU to force 0 V and measure current with a 
current limit of at least 1 mA. A current measurement of approximately 0 mA indicates a proper 
discharge. The Keithley Instruments ACS Basic software executes this discharge procedure after 
completing a High Voltage CV test. ACS Basic will set the Model 2657A output to 0 V with a current 
limit of 1 mA and hold for 1 second prior to turning off the output. See the below graphic for an 
illustration. 

Figure 85: Model 2657A executing discharge 
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Model 8010 connections 
Use the following graphics to connect your SMUs, PCT-CVU, and CVU-3K-KIT to the Model 8010. 
You will need to reference these drawings for both the connection compensation and capacitance 
measurement procedures. 

The ground wires must be attached to a known protective earth (safety ground) before 
turning on the instruments. Failure to attach the ground wires to a known protective earth 
(safety ground) may result in electric shock. 

 

The following graphics rely upon a SMU per bias tee.  With the Model 2600-PCT-1B and 2600-PCT-
2B, there are not enough appropriate SMUs to connect to bias tees. For these configurations, 
connect the force terminal of the GNDU of the PCT-CVU to the bias tee that connects to the Source 
terminal of the FET or the Emitter terminal of the BJT or IGBT. 

 

Connecting instruments to the Model 8010 for power MOSFET 
capacitance measurements 

Model 8010 Crss test connections 
The next graphic shows the Model 8010 SMU, PCT-CVU, and CVU-3K-KIT connections for the Crss 
test. 
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Figure 86: Model 8010 CVU-3K-KIT_3-Term_CRSS_CGD 
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Model 8010 Ciss test connections 
The next graphic shows the Model 8010 SMU, PCT-CVU, and CVU-3K-KIT connections for the Ciss 
test. 

Figure 87: Instrument connections to the Model 8010 for Ciss test 

 
 



Section 5: C-V applications on power MOSFETs Series 2600-PCT-xB Parametric Curve Tracer User's Manual 
 

5-12 PCT-900-01 Rev. A / January 2015 

 

Model 8010 Coss test connections 
The next graphic shows the Model 8010 SMU, PCT-CVU, and CVU-3K-KIT connections for the Coss 
test. 

Figure 88: Instrument connections to the Model 8010 for the Coss test 
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Connecting the Model 8010 to the device for power MOSFET 
capacitance measurements 

Model 8010 connections to the device for Crss 
The next graphic shows the Model 8010 connections to a power MOSFET for the Crss test. 

Figure 89: Model 8010 Device connections for Crss test 

 
 

Model 8010 connections to the device for Ciss and Coss 
 

Figure 90: Model 8010 device connections for Ciss and Coss tests 
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Model 8020 connections 

Connecting instruments to the Model 8020 for power MOSFET 
capacitance measurements 

The following graphics rely upon a SMU per bias tee. With the Model 2600-PCT-1B and 2600-PCT-
2B, there are not enough appropriate SMUs to connect to bias tees. For these configurations, 
connect the force terminal of the GNDU of the PCT-CVU to the bias tee that connects to the Source 
terminal of the FET or the Emitter terminal of the BJT or IGBT. 

 

Model 8020 Crss test connections 
The following graphic shows the Model 8020 connections for the Crss test. 

Figure 91: Instrument Connections to the Model 8020 for the Crss test 
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Model 8020 Ciss test connections 
The next graphic shows the Model 8020 connections for the Ciss test. 

Figure 92: Instrument Connections to the Model 8020 for the Ciss test 
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Model 8020 Coss connections 
The next graphic shows the Model 8020 connections for the Coss test. 

Figure 93: Instrument Connections to the Model 8020 for the Coss test 
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Connecting the Model 8020 to the device for power MOSFET 
capacitance measurements 

Model 8020 test connections to the device 
The next graphic shows the Model 8020 connections to the device under test for Ciss, Coss, and 
Crss measurements. 

Figure 94: Model 8020 connections to the device 
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Perform connection compensations on C-V measurements 
Stray capacitance, resistance, and inductance in the test setup cause measurement errors. These 
errors will vary with setup and their impact varies with frequency. To remove these errors from the 
measurement, perform connection compensation. Because there are connection changes between 
capacitance measurements of a power MOSFET, each capacitance measurement requires a 
separate open and short compensation. ACS Basic stores correction data for each capacitance 
measurement. This section will detail how to perform the compensations for the three circuit-level 
capacitance measurements: Ciss, Coss, and Crss.  

Perform open and short compensation whenever the test configuration changes. This includes 
cabling and adapter changes, as well as changes to the bias tee configurations. 

Though compensations can be performed individually for each capacitance measurement, this 
section steps you through the open and short compensations for all of the circuit level capacitance 
parameters (Ciss, Coss, and Crss).  
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Ciss compensation 

Before you begin connection compensations, make sure that you have connected your instruments 
correctly. See the Model 8010 Ciss test connections (on page 5-11) or Model 8020 Ciss test 
connections (on page 5-15) topics of this manual. 

Perform open compensation for the Ciss measurement using the Model 8010: 

1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 
fixture (see the below graphic), then close the lid of the test fixture. 

Figure 95: Internal 8010 connections for Ciss open compensation 
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2. If using the Model 8020, remove the DUT or lift the probes on a probe station to disconnect from 
the device. 

3. In ACS Basic, open Multi-Mode test if it is not already open. Refer to section 4 for information on 
setting up a Multi-mode project. 

4. Click on the Tools menu and Select CVU Compensation (see below graphic). 

Figure 96: Tools > CVU Compensation 
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5. The CVU Connection Compensation window is displayed (see below graphic). 

Figure 97: CVU connection compensation dialog window options 

 

If this CV connection compensation window does not appear, make sure that you device interface 
settings are correct in the hardware configurator. The bias tee checkbox must be selected. Refer to 
Getting started with ACS Basic (on page 3-1) for more details. 

6. Select the appropriate CVU Cable Length according to the cables that you have. 1.5m cables are 
supplied with the PCT-CVU. 

7. Under 3-terminal measurement, select the Circuit-level Parameters radio button in the Level 
Setting. 
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8. Select the Measure Open Ciss, Cib, Cies button. 
9. The Measure Open for Ciss, Cib, Cies window is displayed (see the below graphic). Clicking the 

Help button displays the detailed information for compensation connections and provides the 
translation for device terminal terminology. 

Figure 98: Measure Open dialog window 

 

10. Click the Start button to begin the open compensation measurement. 
11. A progress window will appear. Open compensation may take up to 90 seconds to complete. 
12. When the measurement is complete, click OK to confirm (see the below graphic). 

  

13. Leave the CVU Connection window open for the rest of the compensations. 
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Perform short compensation for Ciss measurement 
1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 

fixture. 
2. Use a banana jumper to short the gate and source terminals (see the next graphic), then close 

the lid of the test fixture. 

Figure 99: Internal 8010 connections for Ciss short compensation 
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3. If using the Model 8020, remove or disconnect from the device and place a short between the 
connections to the gate and source terminals. Note the location of the short in the following figure. 

Figure 100: Ciss measurement, short compensation 
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4. Select the Measure Short Ciss, Cib, Cies button. 

Figure 101: CVU connection compensation settings 

 

5. The Measure Short for Ciss, Cib, Cies window is displayed (see the below graphic). Clicking the 
Help button displays the detailed information for short compensation connections. It also provides 
the translation for device terminal terminology. 
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6. Click the Start button to begin the short compensation measurement. 
7. A progress window will appear. Short compensation may take up to 90 seconds to complete. 
8. When the measurement is complete, Click OK to confirm (see the below graphic). 

Figure 102: Compensation complete dialog window 

 
 

9. Leave the CVU Connection window open for the rest of the compensations. 
10. Remove the shorting wire to proceed to the next connection compensation measurement. 
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Coss compensation 

Before you begin connection compensations, make sure that you have connected your instruments 
correctly. See the Model 8010 Coss test connections (on page 5-12) and Model 8020 Coss test 
connections (on page 5-16) sections of this manual. 

Perform open compensation for Coss measurement 

1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 
fixture (see the below graphic), then close the lid of the test fixture.  

Figure 103: Internal 8010 connections for Coss open compensation 
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2. If using the Model 8020, remove the DUT or lift the probes on a probe station to disconnect from 
the device. 

3. In the CVU Connection Compensation dialog window of the ACS Basic software, select the 
Measure Open Coss, Cob, Coes button (see the below graphic). 

Figure 104: CVU connection compensation dialog window options 
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4. The Measure Open for Coss, Cob, Coes window is displayed. Clicking the Help button displays 
the detailed information for compensation connections and provides the translation for device 
terminal terminology. 

Figure 105: Measure Open dialog window 

 
 

5. Click the Start button to begin the open compensation measurement. 
6. A progress window will appear. Open compensation may take up to 90 seconds to complete 
7. When the measurement is complete, click OK to confirm (see the below graphic). Leave the CVU 

Connections Compensation dialog window open for the remaining compensations. 

Figure 106: Compensation complete dialog window 
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Perform short compensation for Coss measurement 
1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 

fixture (see the below graphic). 
2. Short the Source and Drain terminals using a banana jumper, then close the lid of the Model 

8010. 

Figure 107: Internal Model 8010 connections for Coss short compensation 
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3. If using the Model 8020, remove or disconnect from the device and place a short between the 
connections to the drain and source terminals. In this compensation, we are only compensating 
for the larger of Cgd and Cds (typically Cds). Note the location of the short in the following 
graphic. 

Figure 108: Coss measurement, short compensation 
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4. In the CVU Connections Compensation window, click the Measure Short Coss, Cob, Coes 
button. 

Figure 109: CVU connection compensation dialog window options 

 
 

5. The Measure Short for Coss, Cob, Coes window is displayed (see the below graphic). Clicking 
the Help button displays the detailed information for short compensation connections. It also 
provides the translation for device terminal terminology. 

Figure 110: Measure short for Coss, Cob, Coes dialog 
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6. Click Start in the Measure Short for Coss, Cob, Coes window to start the short compensation 
measurement. 

7. While running the short compensation measurement, a progress window will appear. The short 
compensation will take less than 90 seconds to complete. 

8. When the measurement is complete, Click OK to confirm (see the below graphic). 

Figure 111: Compensation complete dialog window 

 
 

9. Remove the shorting wire to proceed to the next connection compensation measurement. Leave 
the CVU connection compensation dialog window open to complete the remaining 
compensations. 

 

Crss compensation 

Before you begin connection compensations, make sure that you have connected your instruments 
correctly. See the Model 8010 Crss test connections (on page 5-10) and Model 8020 Crss test 
connections (on page 5-14) sections of this manual. 

Perform an open compensation for Crss measurement 

1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 
fixture (see the below graphic), then close the lid of the test fixture. 

Figure 112: Internal 8010 connections for Crss short compensation 
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2. If using the Model 8020, remove the DUT or lift the probes on the probe station to disconnect 
from the device. 

3. In the CVU Connection Compensation window, select the Measure Open Crss, Cres button. 

Figure 113: CVU connection compensation dialog window options 
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4. The Measure Open for Crss, Cres window is displayed (see the below graphic). Clicking the Help 
button displays the detailed information for compensation connections and provides the 
translation for device terminal terminology. 

Figure 114: Measure Open dialog window 

 
 

5. Click the Start button to begin the open compensation measurement. 
6. A progress window will appear. The open compensation will take up to 90 seconds to complete. 
7. When the measurement is complete, select the OK button to confirm (see the below graphic). 

Leave the CVU Connection Compensations dialog window open for the remaining 
compensations. 

Figure 115: Compensation complete dialog window 
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Perform short compensation for Crss measurement 
1. If using the Model 8010, make sure that no device is inserted in the device socket in the test 

fixture, then install a shorting wire between the drain and gate using a banana jumper (see the 
below graphic). Close the lid of the test fixture.  

Figure 116: Internal 8010 connections for Crss short compensations 

 



Series 2600-PCT-xB Parametric Curve Tracer User's Manual Section 5: C-V applications on power MOSFETs 
 

PCT-900-01 Rev. A / January 2015 5-37 

 

2. For the Model 8020 remove or disconnect from the device and place a short between the 
connections to the gate and drain terminals. Note the location of the short in following figure. 

Figure 117: Cgd / Crss measurement, short compensation 
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3. Select the Measure Short Crss, Cres button. 

Figure 118: CVU connection compensation dialog window options 

 
 

4. The Measure Short for Crss, Cres window is displayed. Clicking the Help button displays the 
detailed information for compensation connections and also provides the translation for device 
terminal terminology (see the below graphic). 

Figure 119: Measure Short for Crss, Cres dialog 
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5. Click the Start button to begin the open compensation measurement. 
6. A progress window will appear. The open compensation will take less than 90 seconds to 

complete. 
7. When the measurement is complete, select the OK button to confirm (see the below graphic). 

Figure 120: Compensation complete dialog window 

 
 

8. Remove the shorting wire between the source and drain terminals. For the Model 8010, also 
remove the connection between the source terminal and the 8010 chassis. 

All connection compensations are now complete. Close the CVU Connections Compensations 
window in ACS Basic by clicking the X in the upper right corner of the window. 
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Make a Ciss measurement 

Before you make measurements, make sure that you have connected your instruments correctly. 
See the Model 8010 Ciss test connections (on page 5-11) or Model 8020 Ciss test connections (on 
page 5-15) sections of this manual. 

Connect to the device 

If using the Model 8010, insert the device into the 8010 test fixture. If using the Model 8020, make 
contact with the device at the probe station. 
Software procedure 

Ensure that Multi-test mode is open in the ACS Basic software. See Collecting I-V curves in Multi-test 
mode (see "Collecting I-V curves in trace mode" on page 4-4) for detailed software configuration. 
Make a Ciss measurement 

Make sure that you have performed open and short connection compensations prior to making a 
measurement. See the previous section, Perform connection compensations on C-V measurements 
(on page 5-18), for more information and instructions. 

1. Select the nPowerMOSFET from Select a Device panel (see the below figure). 

Figure 121: Selecting the nPowerMOSFET device 
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2. Select Parametric from Test Category (see below graphic). 

Figure 122: Test options 

 
 

3. Select KI42CVU from Instrument Models. 
4. Select Ciss from Test Modules. 
5. Click the Add Test button to add the Ciss test to the project tree. 

• If prompted with Choose device to add the test, select the desired device from the drop-down menu and 
click OK (see below figure). 

Figure 123: Choosing device 
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6. Double Click on Ciss test (see the below graphic) in the project tree to open the test to display the 
Ciss test module. 

Figure 124: Ciss test in project tree 

 
 

The Ciss module is a Python Test Module (PTM). As such, it references global SMU numbers. If you 
are using a Model 4200-SCS and you have SMU cards installed in its chassis, the SMU identification 
numbers will differ from those previously used for I-V tests. Refer to the Hardware Configuration 
topic in the ACS Basic User's Manual for details. 

 

7. Click the Setup tab. 

Figure 125: Ciss setup tab 
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8. Assign the SMUs as follows. These settings assume the use of a 2600-PCT-3B or 2600-PCT-4B 
as configured according to the Getting started with ACS Basic (on page 3-1) section of this 
manual. Use the actual SMU number for your configuration (see the below graphic). 

Figure 126: Ciss SMU assignments and block diagram (Model 8010 connections) 

 

If using the Model 8010, use these configuration settings 
• Drain DC: SMU3 (2657), AC: CVU_H 
• Gate DC: SMU2 (2600B, ch B), AC: CVU_L 
• Source DC: SMU1 (2600B, ch A), AC: CVU_H 

If using the Model 8020, use these configuration settings 
• Drain DC: SMU3 (2657), AC: CVU_H 
• Gate DC: SMU1 (2600B, ch A), AC: CVU_L 
• Source DC: SMU2 (2600B, ch B), AC: CVU_H 

The Gate AC and Source AC instruments are linked automatically. This represents the hardware 
connection of the white SMA cable (CA-406A) shorting the two 200 V bias tees. 
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Hover the mouse pointer over the SMU pad to display the corresponding instrument model number. 

9. Enter your desired values in the test settings table. 
10. For the included sample device (Fairchild part number FQH8N100C), sweep voltage at the drain 

from 0 - 1000 V in 10 V steps.  
11. Adjust the sweep values by clicking on the "Source" field for the drain SMU. 
12. Configure the drain SMU to measure voltage. 
13. Configure the gate and source SMUs to have a source function of bias V with a source value of 

0V. 
14. For the CVU, set the measurement frequency to 1 MHz by selecting the Frequency field and then 

selecting 1 MHz from the list box. 
15. Use the default ACV of 30 mVrms. 
16. Use the Cp-Gp-D model. 

Figure 127: Test settings table 
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For the Ciss test module, the capacitance measurement function is fixed to capacitance vs. voltage. 
To view capacitance as a function of frequency, use the Generic HV C-V Test under the 
CommonLib_CV test category.  Refer to the ACS Basic software user's manual for information on 
using this test module. 

17. Click the Timing button.  
18. Ensure that C-V optimized is selected and the presoak time is 5 seconds, then click OK to close 

the window. See the below graphic. 

Figure 128: C-V timing window 

 
 

19. Select the Open and Short boxes in the CVU Connection Compensation area to apply the 
compensation to the measured data. 

The latest compensation will be loaded automatically. If no prior compensation has been performed, 
you may receive the below error message (see the below graphic). To perform the compensation, 
see the previous section, Perform connection compensation on C-V measurements (see "Perform 
connection compensations on C-V measurements" on page 5-18). 

Figure 129: Compensation warning 
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If you have the Model 8010 and are using the CVU-3K-KIT, you can also use built-in compensation 
data by selecting the "Using 8010 factory compensation" checkbox. This allows you to make quick 
validation on the device capacitance without performing the complete compensation for your specific 
environment. 

20. Sample data and pilots are included with the test. Switch to the Data tab (see the following 
graphic). 

Figure 130: Data tab 

 
 

21. Click the Run icon to start the test. The results should appear close to those in the below graphic. 

Figure 131: Run icon 

 
 

If high voltage is used during the test, make sure a proper discharge procedure is 
performed before removing the top cover the Model 8020 or making connection changes 
inside of the Applications Test Fixture. 
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Make a Coss measurement 
Coss measurement connection verification 

Before you make measurements, make sure that you have connected your instruments correctly. 
See the Model 8010 Coss test connections (on page 5-12) or Model 8020 Coss test connections (on 
page 5-16) sections of this manual. 

Connections to the device within the Model 8010 or at the device connections panel of the Model 
8020 are the same as for the Ciss test. Therefore, the connections are not changed. 

Make a Coss measurement 

Make sure that you have performed open and short connection compensations prior making a 
measurement. See the previous section, Perform connection compensations on C-V measurements 
(on page 5-18), for more information and instructions. 

1. Open the test library by clicking on "Project" in the Navigator or by clicking the Library icon in the 
vertical tool bar. 

2. Select the nPowerMOSFET from Select a Device panel (see the below figure). 

Figure 132: PCT_CossMeas1 
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3. Select Parametric from Test Category (see below graphic). 

Figure 133: Test options 

 
 

4. Select KI42CVU from Instrument Models. 
5. Select Coss from Test Modules. 
6. Click the Add Test button to add the Coss test to the project tree. 

• If prompted with Choose device to add the test, select the desired device from the drop-down menu and 
click OK (see below figure). 

Figure 134: Choosing device 
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7. Double Click on the Coss test in the project tree to open the test to display the Coss test module 
(see the below figure). 

Figure 135: Coss test in project tree 

 
 

The Ciss module is a Python Test Module (PTM). As such, it references global SMU numbers. If you 
are using a Model 4200-SCS and you have SMU cards installed in its chassis, the SMU identification 
numbers will differ from those previously used for I-V tests. Refer to the Hardware Configuration 
topic in the ACS Basic User's Manual for details. 

8. Click on the setup tab.  

Figure 136: Ciss setup tab 
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9. Assign the SMUs as follows. Use the actual SMU number for your configuration (see the below 
graphic). 

Figure 137: Coss SMU assignments and block diagram (Model 8010 connections) 

 
 

If using the Model 8010, use these configuration settings 
• Drain DC: SMU3 (2657A), AC: CVU_L 
• Gate DC: SMU2 (2600B, ch B), AC: CVU_H 
• Source DC: SMU1 (2600B, ch A), AC: CVU_H 

If using the Model 8020, use these configuration settings 
• Drain DC: SMU3 (2657A), AC: CVU_L 
• Gate DC: SMU1 (2600B, ch A), AC: CVU_H 
• Source DC: SMU2 (2600B, ch B), AC: CVU_H 

The Gate AC and Source AC instruments are linked automatically in the software. This represents 
the hardware connection of the white SMA cable (CA-406) shorting the two 200 V bias tees. 
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Hover the mouse pointer over the SMU pad to display the corresponding instrument model number. 

10. For the included sample device (Fairchild part number FQH8N100C) sweep voltage at the drain 
from 0 - 1000 V in 10 V steps. Adjust the sweep values by clicking on the Source field for the 
drain SMU. 

11. Configure the drain SMU to measure voltage. 
12. Configure the gate and source SMUs to have a source function of bias V with a source value of 0 

V. 
13. For the CVU, set the measurement frequency to 1 MHz by clicking on the Frequency field and 

selecting 1 MHz from the list box. 
14. Use the default ACV of 30 mVrms. 
15. Use the CP-G-D model. 

Figure 138: Test settings table 
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For the Coss test module, the capacitance measurement function is fixed to capacitance vs. voltage.  
To see capacitance as a function of frequency, use the Generic HV C-V Test under the 
CommonLib_CV test category. Refer to the ACS Basic software user's manual for information on 
using this test module. 

16. Click on the Timing button.  
17. Ensure that CV optimized is selected and the presoak time is 5 seconds, then click OK to close 

the window. See the below graphic. 

Figure 139: C-V timing window 

 
 

18. Check the Open and Short boxes in the CVU Connection Compensation area to apply the 
compensation to the measured data. 

The latest compensation will be loaded automatically. If no prior compensation has been performed, 
you may receive the below error message (see below graphic). To perform the compensation, see 
the previous section, Perform connection compensation on C-V measurements (see "Perform 
connection compensations on C-V measurements" on page 5-18). 

Figure 140: Warning that compensation was not performed 

 
 



Series 2600-PCT-xB Parametric Curve Tracer User's Manual Section 5: C-V applications on power MOSFETs 
 

PCT-900-01 Rev. A / January 2015 5-53 

 

If you have the Model 8010 and are using the CVU-3K-KIT, you can also use built-in compensation 
data by selecting the "Using 8010 factory compensation" checkbox. This allows you to make quick 
validation on the device capacitance without performing the complete compensation for your specific 
environment. 

19. Sample data and pilots are included with the test. Switch to the Data tab (see the following 
graphic). 

Figure 141: Data tab 

 
 

20. Click the Run icon to start the test (see below graphic). 

Figure 142: Run icon 
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21. When the test runs you will note that this device has a large change in Coss data.  Therefore a 
log scale on the y-axis may be appropriate. You can adjust the Plot and Axis settings by right-
clicking the plot area. 

Figure 143: C-V Coss test plot axis settings 
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22. Select the Axis settings tab.  
23. Under Y1, select Log, then click the Save button (see the following graphic). 

Figure 144: Coss axis settings window 

 

You will note that there is a large change in the data between 0.1 and 10 V. You can take a closer 
look at this change by running a second sweep and appending the data.  

24. Click on the setup tab. 

Figure 145: Ciss setup tab 
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25. Double-click the source field for the Drain SMU to adjust the SweepV settings to sweep from 0.1V 
- 10 V in 0.1 V steps. 

Figure 146: Coss SweepV settings 
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26. Click on the Data tab, then click the "Append Run" icon in the toolbar. 
27. You can also adjust the X-axis to a log scale. Right-click on the graph and select "Plot and Axis 

Settings". Click on the "Axis Settings" tab and then check the "Log" checkbox under X.  Uncheck 
"Auto" and set the minimum to 10e-1 and the max to 10e3. 

Figure 147: Coss plot axis settings Log X 
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28. Click the Save button. 
29. When the test completes, the data should appear similar to the below graphic. 

Figure 148: Coss results from both sweeps 

 
 

If high voltage is used during the test, make sure a proper discharge procedure is 
performed before removing the top cover the Model 8020 or making connection changes 
inside of the Applications Test Fixture. 
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Make a Crss measurement 
Crss measurement connection verification 

Before you make measurements, make sure that you have connected your instruments correctly. 
See the Model 8010 Crss test connections (on page 5-10) or Model 8020 Crss test connections (on 
page 5-14) sections of this manual. 

There is one change within the Model 8010 test fixture, but no changes at the device connections 
panel of the Model 8020 for this test. 
Make a Crss measurement 

Make sure that you have performed open and short connection compensations prior making a 
measurement. See the previous section, Perform connection compensations on C-V measurements 
(on page 5-18), for more information and instructions. 

1. Open the test library in the ACS Basic software by clicking on Project in the navigator or by 
clicking the library icon in the vertical toolbar. 

2. Select the nPowerMOSFET from Select a Device panel (see the below figure). 

Figure 149: Selecting the nPowerMOSFET device 
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3. Select Parametric from Test Category (see below graphic). 

Figure 150: Test options 

 
 

4. Select KI42CVU from Instrument Models. 
5. Select Crss from Test Modules. 
6. Click the Add Test button to add the Crss test to the project tree. 

• If prompted with Choose device to add the test, select the desired device from the drop-down menu and 
click OK (see below figure). 

Figure 151: Choosing device 
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7. Double Click on the Crss test in the project tree to open the test to display the Crss test module 
(see the below figure). 

Figure 152: Crss test in project tree 

 
 

8. Click on the setup tab. 

Figure 153: Ciss setup tab 

 
 

9. Assign the SMUs as follows. Use the actual SMU number for your configuration (see the below 
graphic). 

Figure 154: Crss SMU assignments and block diagram (Model 8010 connections) 
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If using the Model 8010, use these configuration settings 
• Drain DC: SMU3 (2657A), AC: CVU_H 
• Gate DC: SMU2 (2600A, ch B), AC: CVU_L 
• Source DC: SMU1 (2600A, ch A), AC: AC GUARD 

If using the Model 8020, use these configuration settings 
• Drain DC: SMU3 (2657A), AC: CVU_H 
• Gate DC: SMU1 (2600B, ch A), AC: CVU_\L 
• Source DC: SMU2 (2600B, ch B), AC: AC GUARD 

Hover the mouse pointer over the SMU pad to display the corresponding instrument model number. 

10. For the included sample device, Fairchild part number FQH8N100C, sweep voltage at the drain 
from 0 - 1000 V in 10 V steps. Adjust the sweep values by clicking on the Source field for the 
drain SMU. 

11. Configure the drain SMU to measure voltage. 
12. Configure the gate and source SMUs to have a source function of bias V with a source value of 0 

V. 
13. For the CVU, set the measurement frequency to 1MHz by clicking on the Frequency field and 

selecting 1MHz from the list box.  
14. Use the default ACV of 30 mVrms 
15. Use the CP-G-D mode. 

Figure 155: Test settings table 
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For the Crss test module, the capacitance measurement function is fixed to capacitance vs. voltage.  
To see capacitance as a function of frequency, use the Generic HV CV Test under the 
CommonLib_CV test category. Refer to the ACS BE user's manual for information on using this test 
module. 

16. Click the Timing button. 
17. Ensure that CV optimized is selected and the presoak time is 5 seconds. 

Figure 156: C-V timing window 

 
 

18. Check the Open and Short boxes in the CVU Connection Compensation area enable to apply the 
compensation to the measured data. 

The latest compensation will be loaded automatically. If no prior compensation has been performed, 
you may receive the below error message (see below graphic). To perform the compensation, see 
the previous section, Perform connection compensation on C-V measurements (see "Perform 
connection compensations on C-V measurements" on page 5-18). 

Figure 157: Warning that compensation was not performed 
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19. Sample data and pilots are included with the test. Switch to the Data tab (see the following 
graphic). 

Figure 158: Data tab 

 
 

20. Click the Run icon to start the test (see below graphic). 
 

Figure 159: Run icon 
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21. As was true for the Coss data for this device, there is a large change in the measured data for 
Crss. You can adjust the Plot and Axis settings to plot on a log scale by right-clicking the plot area 
and selecting Plot and Axis settings.  

22. Check the "Log" checkbox for Y1. 
23. Take a closer look at the data between 0.1 and 10 V by running a second sweep and appending 

the data.  Go back to the Setup tab and change the sweep settings by double clicking the Source 
field for the Drain SMU. 

24. Append the data from this second sweep to the original data by clicking the AppendRun button in 
the tool bar. 

25. Set the X-axis to log scale by right-clicking the graph and selecting "Plot and Axis Settings".  
26. Select the Axis settings tab, then check the "Log" checkbox for the X axis. Uncheck "Auto" and 

enter min and max scales of 10e-1 and 10e3 respectively.  
27. Click the Save button to apply the settings. The final results should be similar to the below 

graphic.  
 

Figure 160: Crss data run 2 

 
 

If high voltage is used during the test, make sure a proper discharge procedure is 
performed before removing the top cover the Model 8020 or making connection changes 
inside of the Applications Test Fixture. 

 



Section 5: C-V applications on power MOSFETs Series 2600-PCT-xB Parametric Curve Tracer User's Manual 
 

5-66 PCT-900-01 Rev. A / January 2015 

 

Optimizing Ciss measurement connections for difficult measurements 
Crss measurement accuracy is affected by the size of the Cds and Cgs capacitors. The proximity of 
AC guard to the device under test also impacts Crss accuracy. AC guard should be very near the 
virtual ground of the C-V meter, which is the return shield for the C-V measurements (the outer shell 
of the triaxial cable). 

If AC guard differs widely from virtual ground, then it is not an effective guard terminal. In some 
cases, you will need to adjust connections in order to get a better AC guard voltage and thus a better 
Crss measurement. Evidence of a need to change connections is when Crss differs from the 
expected value or is very unstable across frequency. To improve measurements, you can also 
connect the FET Source Terminal to ground close to the device under test. The Model 8010 uses 
these optimized connections by using a banana jumper and alligator clip to connect the FET source 
terminal to the chassis of the Model 8010. See the below graphic for details. 

Figure 161: Model 8010 test board improved connection setup 
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When using the Model 8020 with a probe station, you may find that connecting to the Common LO 
terminal or using a shorting plug at the connector nearest the probe accomplishes this. See the 
following graphics for details. 

The first connection diagram (see next graphic) details connections to Common LO. The diagram 
following this shows how to make a short at the device under test, perhaps at the probe station 
positioner. It may be possible to do this using an adapter that shorts the center conductor to the outer 
shell, so long as the outer shell connects to chassis ground. 

Figure 162: Crss measurement optimization, method 1 
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Figure 163: Crss measurement optimization, method 2 
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Missing cables 
Q: I opened my instrument box and didn't find any cables to connect to the test fixture or interface 
panel. 

A: All cables required to connect instrument to 8010 or 8020 are individually packaged and are 
included in the "Open Me First" box. 

 

2600-PCT-1B and C-V measurements 
Q; I have a 2600-PCT-1B and I want to use C-V. I don't have a third SMU. How do I connect to the 
DC input of the third bias tee? 

A: Connect the force terminal of the GNDU of the PCT-CVU to the third bias tee. In this configuration, 
there will be no bias possible at the third bias tee. Detailed drawings of this connection this using the 
2636B and the CVU-200-KIT Bias Tee Kit are provided in the Model 8010 User's Manual. See the 
Keithley Instruments website at www.keithley.com http://www.keithley.com for more information. 

 

2600-PCT-2B and C-V measurements 
Q:  I have a 2600-PCT-2B and I want to use C-V.  Can I connect the Model 2651A to the third bias 
tee?  How can I do this?  

A:  Do not connect the Model 2651A to a bias tee, because the bias tee cannot support the current 
capability of the instrument.  Connect the force terminal of the GNDU of the PCT-CVU to the third 
bias tee. In this configuration, there will be no bias possible at the output of the third bias tee.  

 

Section 6 

Troubleshooting FAQs 

http://www.keithley.com/
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Custom tests in ACS Basic 
Q: Can I use ACS Basic to create tests not included in the device library? 

A: Yes. You can use ITMs to configure specific settings for each SMU connected to the device or you 
can write custom code using Script Test Modules (STMs) or Python Test Modules (PTMs) to control 
other instruments. See the ACS Basic manual for more information on creating custom tests. 
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